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Digital Dave
&“Digital Dave answers your tech questions.” by Digital Dave

Dave discusses Internet privacy and how much Web sites may know about you.

Dear Digital Dave,

Just how much information can they get about you when you go on the Internet? Is it all hype or is
there a real problem.

Jay
San Diego, CA

Dear Jay,

While there is a certain amount of information about your computer and location that you can't hide, how much anyone is
able to collect on you is largely up to you. If you never surf the Web, then you won't leave a trail. But, if you want to reap
the benefits of the Internet, then there is a minimum which you will inevitably give up.

Standard Web Browser Information

There is specific information that all Web browsers provide to the Web servers which host pages. It is enough to tell the
host what type of computer you're using and your general geographic location. The following are the types of data
immediately available via your Web browser:

User-Agent—The Web browser you're using whether Internet Explorer, Google Chrome, Firefox, Safari, Opera, or
one of the mobile browser is a variable returned to the host server. From this information, the type of computer (Windows,
Mac, etc.) can usually be identified. An example of the user-agent returned is:

Mozilla/5.0 (iPad; U; CPU OS 3_2_1 like Mac OS X; en-us) AppleWebKit/531.21.10 (KHTML, like Gecko) Mobile/7B405

As you can see, the device is readily identified as an iPad, plus the operating system is part of the string. This information
is often used by a Web site to steer you to the proper download for software or to customize the site for performance on
that platform.

Remote Address—The remote address (REMOTE_ADDR) variable contains the IP for your computer, modem or
router, whichever one is exposed to the Internet. Usually the IP detected is assigned by the Internet service provider and
will appear at the point where the Internet connection enters the building (the modem). Since the IP usually come from the
service provider, general geographic location can be determined from this set of numbers. This information is commonly
used to deliver advertising from the local community when you do a Web search.

These variables can be spoofed by people who are trying to hide their computer and IP, but most people don't do this so
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the information is normally useful (although not too revealing) to Web sites.
Information in Cookies

One of the best ways for Web sites to track you is through cookies. A cookie is a tiny file which is created by a Web site
and saved on your computer via the Web browser. The Web site is limited in that it can only read from and write to its own
cookie. The cookie file is text-only making it virtually impossible to be a source of malware.

Generally, when a cookie is set by a Web site, your computer is assigned an identifier called a session token which is
saved in the cookie. Whenever you return to the site, the cookie is read and the server can identify you as a returning
visitor. If you've provided the information, a cookie can contain your name or any other text information that you submitted
to the site. If you don't provide any personal information, then nothing can be saved.

Third-party cookies are assigned by agents other than the primary site. This can happen when content, such as an
advertisement, is provided from a source other than the Web site you're visiting. These third-party cookies can be used to
track your movement around the Web.

For example, DoubleClick is a marketing service that tracks people by putting third-party cookies on their computer via
sites such as PayPal and Google (who owns DoubleClick). As you move from one site to another, each of which work with
DoubleClick, your movement and activities can be tracked. This information is not used so much to identify you as it is to
determine your preferences for delivering advertising to you.

If you don't want to be tracked by third-party cookies, the solution is to block them in your Web browsers. Virtually all Web
browsers have a setting for blocking third-party cookies.

It is not advisable to block all cookies since many Web sites use their primary cookies to save setup information. If you
block these cookies, then you will need to go through setup every time you visit the site. (Erasing all cookies has the same
effect.) For example, ComputorEdge saves your selected geographic region (San Diego, Colorado, etc.) in the cookie.
When you visit ComputorEdge, the cookie is checked and you're directed to the appropriate region. If you turned off
cookies completely, you would need to pick the region each time you visit (unless the variable is being accessed from
your Bookmarks).

Services such as DoubleClick can still track via your IP address, but this information is much less useful since IPs often
change and individual computers at the same location cannot be identified.

Incognito Browsing

Another source of protection is incognito, or private, browsing. When in this Web browse mode, the cookies and history
are not recorded or saved. From the perspective of the Web this is the same as blocking all cookies. Private browsing
primarily protects you from people in your own house snooping into your activities on the Web.

The Information You Put on the Web

The greatest privacy risk you have when on the Web comes from the personal information put into sites such as
Facebook and other social media. You are depending upon the goodwill of the Web site operators to protect your
information. Most people know to protect their credit card numbers and Social Security Number, but many people are lax
about other details of their lives. These little pieces of data can add up to a complete profile of a person.

First, be sure to implement whatever privacy settings are available. It is amazing how many people leave their entire life
history exposed on Facebook. Anyone could quickly track them down and find out where they live. Be careful what you
post and make sure that you use those privacy settings to prevent strangers from cyber-stalking you. You should only
expose your account to real "Friends" unless you are very careful about what information you post. (Or you just don't care
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who learns everything about you.)

Plus, you never know when a company such as Facebook will decide that your information is ripe for data mining and
sale. There have been a number of incidents where social media companies harvested information for the purpose of
reselling it. Usually there is a strong outcry from the users, but that may not stop the sale.

Remember, once you post something on the Web, there is no way to take it back. Even if you delete something, it may
still be sitting in an archive or someone else's computer.

Digital Dave
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International "Consumer Electronics Show" in Hindsight

The January 2012 International Consumer Electronics Show in Las Vegas didn't have many mind-blowing surprises. But
the Contra Costa Times did a review article called "Best In Show: 6 Gadgets That Defined CES (www.
contracostatimes.com/business/ci_19739275)." More inexpensive Tablet Computers or E-Readers were on
display without last year's industry enthusiasm trying to duplicate the iPad's success.

With PC sales flat-lining, but smartphone sales exploding, companies from Nokia to Intel Corp. are jumping on the
smartphone bandwagon. Long-awaited OLED TVs "with screens made from organic light-emitting diodes" were on display,
to be on sale later this year in the expected $5,000 range. Lighter and more powerful laptop computers were a hit, as well
as a Japanese camera (Canon G1X) that is sophisticated enough to encroach on professional camera territory.

The Seattle Times' Brier Dudley, however, found himself intrigued by a small table display at
CES that hinted at exotic gizmos (seattletimes.nwsource.com/htmi/
technologybrierdudleysblog/2017260101_ces_ 2012 powering_gadgets_with.
html) just around the futuristic corner. He liked Perpetua (www.perpetuapower.com)
with "energy harvesting" gadgets, such as their "thermoelectric devices that convert
temperature differences in dissimilar metals into electricity.” Since 2005, Perpetua has been
selling these systems for industrial use. Now the company is working on smaller, wearable
gadgets to generate electricity from a person's body heat instead of a battery, and/or add
wireless connectivity to personal devices.
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On-Line Diet Betting?

Perhaps inspired by the TV shows on weight-loss, more and more people are competing in on-line diet competitions (www.
mercurynews.com/health/ci_19722313). Online "diet betting” lets the overweight put their game face on, and

wager that they'll lose so much weight in a certain amount of time. These sites (such as WeightLossWars.com) always
get a lot of business at this time of year, when New Year's Diet Resolutions get kicked up a notch with competition and
money prizes. One study found that dieters with money at stake lost more weight that those who didn't put up a wager.
These on-line "diet betting" sites offer motivation, interactive charts, and notes on how well the competition is doing, as well
as healthy eating tips and supportive boosts.

Facebook Culture—Life, Death and History

So how old can you be to have a Facebook account?
How about the fact that two (now deceased) students
(mashable.com/2012/01/06/1915-students-
on-facebook-university-of-nevada/) from the
University of Nevada in Reno in 1910 have uploaded
pictures and profiles? Joe McDonald likes to box and
his favorite musicians include Irving Berlin and Scott
Joplin. He's "in a relationship” with Leola Lewis (they
married in 1915), who enjoys embroidery and reading
Jane Austen and Edgar Allen Poe.

The Facebook accounts were the idea of Donnelyn
Curtis at the U of N, who got permission to post the
former students' profiles from the couple's
granddaughter. Curtis, director of the university's
Research Collections, thought it would be a unique
way to teach a sort of "living history." Curtis did all the
status updates, which were historically accurate for
that time and location. But Facebook abruptly
removed the profiles, saying that they violated the
site's primary registration protocol (mashable.
com/2012/01/10/history-facebook/?WT.
mc_id=obinsite): "You will not create an account
for anyone other than yourself without permission.”

“This is not fair! Facebook has blocked my
account for being dead, but I’'m Undead!™ Since dealing with death is difficult for most, there is
now a Facebook app called "If I Die." It lets posters
upload a final message by text or video, and post it on their wall. The developer, Willook, uses dark humor to encourage
the interested to "leave behind a final farewell, a long-held secret, or even one last stinging insult." After downloading the
app, the user uploads a 5-minute final message to Facebook. The user then appoints three good friends as "trustees", who
all must confirm that user's death in order for Facebook to release the "final message."

Fury over SOPA/PIPA Starts Cyber-War

Congress is working on anti-piracy legislation, motivated by the on-line theft of Hollywood's movies. The U.S. House of
Representives calls their bill the Stop Online Piracy Act (SOPA). The U.S. Senate has a companion bill called Protect
Intellectual Property Act (PIPA). Many legitimate Internet entities were alarmed, fearing that the broadly worded bills could
be used to shut down their sites over mere snippets of unknowingly pirated material. Wikipedia, Craigslist and Reddit
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actually shut down their sites for an entire day in protest.

However, there followed a mid-January take-down of the popular file-hosting site MegaUpload, and its operators were
arrested. Furious hackers reacted (news.cnet.com/8301-27080_3-57362279-245/doj-fbi-entertainment-
industry-sites-attacked-after-piracy-arrests/) with attacks on the U.S. Department of Justice, FBI, and various
Hollywood entities.

After that burst of hacker retaliation, the Senate immediately pulled their PIPA bill. And the House of Representives quickly
followed by pulling their SOPA bill to be redrafted (latimesblogs.latimes.com/technology/2012/01/sopa-bill-
sent-back-to-the-drawing-board-in-wake-of-internet-protests.html). Opponents of the bills were thrilled at the
retreat, calling for more concensus over how to deal with foreign piracy sites.

3D/Replicator Printing

I've already written about how modified computer printers can now "print" layer upon layer of
tissue and bone grafts. Now comes word that 3D Printing (en.wikipedia.org/
wiki/3D__printing), or "additive manufacturing", is now affordable for all kinds of
applications. Sculpteo (www.sculpteo.com/en/) lets designers upload their 3D files, and
have their product printed/manufactured, whether a prototype from a university, or a
personalized piece of artwork. MakerBot Industries (www.makerbot.com) is a Brooklyn-
based 3D printer-for-hire, which CEO Bre Pettis calls "The Replicator", from the Star Trek
universe.

Hacker Update

Beyond the SOPA/PIPA protests, hacktavists have been busy with global attacks (blogs.siliconvalley.com/
gmsv/2012/01/zappos-data-breached-as-hackers-make-waves-worldwide.html), although their true
intentions or desired goals are a little murky. Amazon-owned on-line shoe company, Zappos, had to warn 24 million
customers to change their passwords, since even the site's cryptographically scrambled passwords had been hacked.
Other recent hacks include the disruption of the Israeli stock market and national airline. And a hacker from India
threatened to release the full source code for Symanetec's Norton Antivirus software.

Meanwhile, five Russian hackers responsible for spreading a notorious computer worm on Facebook (www.nytimes.
com/2012/01/17/technology/koobface-gang-that-used-facebook-to-spread-worm-operates-in-the-
open.html) and other social networks, are hiding-in-plain-sight in St. Petersburg, Russia. Called the Koobface Gang, they
have even posted photos of their faces and workspace on Foursquare. Experts say that the Gang's freedom highlights just
how hard it is to apprehend international computer criminals, even when their identities are known.

Perhaps the most disturbing story is that German hackers may be planning to launch their own satellites (www.
csoonline.com/article/697206/hackers-said-to-be-planning-to-launch-own-satellites-to-combat-
censorship?source=rss_data_protection) to bypass Internet censorship, especially as proposed by the SOPA/
PIPA bills in the U.S. The plan, dubbed "Hackerspace Global Grid", was announced last month at the Chaos
Communication Congress in Berlin, Germany. The German hackers have a plan that's a kind of reverse GPS, which uses a
"distributed network of low-cost ground stations that can be bought or built by individuals."

Gaming for Political Goals?

Can videogames be used for CIA goals—here and abroad? Apparently so. In July 2010, Cognito Comics launched an
interactive digital graphic novel (publishingperspectives.com/2010/07/coming-soon-to-your-ipad-an-
interactive-graphic-novel-on-the-cia-and-iran-2/) called Operation Ajax (itunes.apple.com/us/app/cia-
operation-ajax/id472099770?Is=1&mt=8) to be played on the iPad. It was inspired by reporter Stephen Kinzer's best-selling
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book of the 1953 CIA-sponsored coup in Iran. Kinzer approved the project saying "designers on the cutting edge of
technology (are) looking to merge that high-tech with the need to educate Americans about our history and our role in the
world."

A video confession (blogs.siliconvalley.com/gmsv/2012/01/quoted-on-video-

games-and-condemned-american-in-iran.html) by a former U.S. Marine, Amir

Mirzaei Hekmati, captured in Iran on spying charges, described the work he'd done for New

York based Kuma Games (www.kumagames.com/). Kuma is well known in Iran for the

2005 videogame "Assault on Iran", which depicts a fictional American military assault on

that country. Hekmati reportedly confessed that Kuma Games received money from the CIA
to "design and make specific films and videogames to change the public opinion's mindset in the Middle East, and
distribute them among Middle East residents free of charge."

Enticing the Young to Classical Music with Digital Innovation

The New World Symphony (NWS) in Miami, Florida, has turned the staid classical music concert into a vibrant media show
(www.miamiherald.com/2012/01/15/2587959/classical-music-younger-listener.html). Instead of sitting
silently and listening, "listeners are able to wander about, chatting and sipping cocktails, getting up close to peer at the DJ
or the sawing arms of cellists and violinists.” Called "Pulse: Late Night at the New World Symphony", the idea is to draw in
new and younger audiences to classical music, with neon lights and flickering imagery overhead to match the music. Other
integrative formats the NWS is experimenting with include special concerts to explore one composer, or a 'gallery walk'
where the audience moves along to hear music by separate, small ensembles.

Facebook—Social Media Crime-Busting

I've already written about how police and the FBI use Facebook to track down criminals, some by posting their own local
Top Ten Wanted. But last July (2011), it was personal. One of the Top Ten Fugitives wanted by the Utica, New York, police
department decided to taunt police (www.digitaltrends.com/social-media/nyc-fugitive-busted-after-taunting-
police-on-facebook/) on his personal Facebook page with the phrase "Catch me if you can, I'm in Brooklyn." The NYPD
and U.S. Marshals took him up on his challenge, and soon located him in his Brooklyn apartment—posting on Facebook.

The same article also recounts the June 2011 16-hour standoff in a Utah motel room between Jason Valdez and police.
Valdez continued to post status updates on Facebook during the ordeal, and even posted a photo of himself with a female
hostage. A friend even alerted him through Facebook that SWAT was just outside the room. After posting his Good-Bye on
Facebook to loved ones, Valdez shot himself as the SWAT team broke into the motel room.

Last Christmas Eve (December 2011) a Utah woman and her baby were trapped in her home by a vicious ex-boyfriend
who took away her cell phone. Solution? The woman took her laptop into a closet and posted a Facebook status update
calling for help (www.digitaltrends.com/social-media/woman-and-baby-being-held-hostage-saved-after-
facebook-status-update/). Friends on Facebook alerted the local police, who freed the woman and her baby. And dog.
The ex-boyfriend had repeatedly sexually abused her, "as well as threw the baby, and didn't feed the dog."

Green Energy: Industrial Use of Deep Water from Oceans and Lakes

According to Wikipedia, Deep Water Source Cooling (en.wikipedia.org/wiki/Deep_water_source_cooling)
(DWSC) is a great way to cool air for manufacturing and comfort, by using naturally cold water as a heat sink. Cornell
University in Ithaca, New York, and Toronto, Canada, use "geothermal cooling (www.nrel.gov/
applying_technologies/climate _neutral/deep_water_cooling.html)" through nearby lakes.

Hawaii is in the unique position to use "cold, deep seawater" (DSW) as a natural coolant (www.nelha.org/about/
resources.html), as outlined by the Natural Energy Laboratory of Hawaii Authority. DSW is "delivered onshore at a chilly
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43 degrees F from a 2,000 foot depth.” Another major player is Makai Ocean Engineering (www.makai.com/p-swac.
htm) which stresses nearly 90% energy-savings compared to usual coolant costs, with "positive environmental attributes,
and cold seawater available for secondary applications."

According to Next Big Future, Seawater Greenhouses (nextbigfuture.com/2012/01/seawater-greenhouses.
html) imitate the "hydrological cycle where seawater heated by the sun evaporates, cools down to form clouds, and
returns to the earth as rain, fog or condensation.” The process involves pumping in seawater which is evaporated at the
front of the greenhouse to create cool and humid conditions inside. The condensed fresh water is more than five times the
fresh water needed to irrigate the crops inside, with plenty left over to water plants outside the greenhouse.

Apps for War—The Army Marketplace

According to an April 2011 article in Wired, the U.S. Army is working on an app store, called the Army Marketplace (www.
wired.com/dangerroom/2011/04/armys-app-store-for-war/). In theory, soldiers can download Army-relevant
software to their work computers and/or smartphones. The first few dozen apps were created by the soldiers themselves in
an "Apps for the Army" contest in August 2010.

The contest winning apps are everything from "Sigacts”, which lets a soldier access information about bombings and
firefights in his area, to an app for "disaster relief efforts that allows users to search, create and edit maps using Google
Earth." Lt. Col. Gregory Motes, chief of the Army's new Mobile Applications Branch, also wants to generate ideas,
encouraging soldiers to post what they'd like an app to do on a Marketplace forum.

According to an October 2011 article in Wired, Army contractor Raytheon has finally developed an English-to-Arabic
translator app, TransTalk (www.wired.com/dangerroom/2011/10/universal-translator-app/). The smartphone
app lets an English sentence be spoken into it, then the phone is passed to an Arabic speaker who hears the same
sentence in his own language. When the Arabic speaker replies into the phone, an electronic voice in the smartphone
repeats the sentence/answer in English.

Catching Smartphone Thieves? Yup, There's an App for That!

When Harold Malkin went downstairs one morning in mid-January 2012, he discovered that several of his family's
electronics were missing (seattletimes.nwsource.com/html/localnews/2017263569 burglary18m.html)—
including his U.S. Justice Department-issued BlackBerry. The responding Seattle police officer, Kurt Knox, suggested they
try and track the stolen electronics through Malkin's wife's stolen iPhone, which had a GPS location app on it. Malkin didn't
know how to use the "Find My iPhone" app, so he woke up his teenage son, Max. Tech-savvy, 14-year-old Max jumped on
iCloud.com and pulled up a map to show exactly where his mother's iPhone was located. Fifteen minutes later, the thief
was arrested.

Also in January 2012, there was a similar case out of New York City, NYPD officer Robert Garland tracked down (www.
nytimes.com/2012/01/28/nyregion/pursuing-iphone-thief-officer-knew-buttons-to-push.html) a stolen
smartphone, also by using the "Find My iPhone" app. Garland pulled up the app's GPS map and located the general area
of the thief. Once there, Officer Garland spotted a likely suspect and pushed the "Play Sound" button on his own phone.
This triggered a pinging-beep sound from the stolen phone, in the possession of the baffled thief. The culprit was caught
red-handed and the whole operation only took a half hour.

Military Tech

A January 2012 article in Wired, disclosed how the U.S. military is considering a novel approach to prevent counterfeit
goods (www.wired.com/dangerroom/2012/01/dna-counterfeits/) from infiltrating their supply chains. Sub-
contractor Applied DNA Sciences (www.adnas.com), has figured out how to create unique DNA "signatures” out of
plant genomes. "A DNA-marked coating can then be applied to just about anything, from circuit boards to microchips to
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routers.” The DNA can be detected by a handheld scanner or a forensic analysis of a swab of the mark, so the product can
be checked for authenticity all along the supply chain.

A December 2011 article in Information Week discussed how DARPA, the Department of Defense's research arm, is
looking for smartphone app developers to fast-track advanced sensor capabilities for unmanned drones (Www.
informationweek.com/news/government/mobile/232300044). One mobile app idea DARPA is looking for could
fly a swarm of drones as if they were one, by using hidden perimeter security sensors.

Marilyn is a freelance writer and humorist, with a special interest (besides computers and technology) in Science Fiction. A
SF Horror story appeared in July 2011 in Deadman's Tome (www.demonictome.com/). And in January 2012 she had
a SF Police Procedural appearing in Cosmic Crime magazine, and a SF Dystopian Romance appearing in the Strange
Valentines anthology. She also has almost seventy articles on Helium.com (www.helium.com/users/573405/
show _articles), and is writing a humorous Young Adult SF series, Chronicles of Mathias (www.amazon.com/
Chronicles-Mathias-One-Reptilian-Rebirth/dp/1598249002). Volumes One and Two have received a "Gold Star for
Excellence" from TeensReadToo.com (www.teensreadtoo.com/ReptilianRebirth.html), and are available from
most on-line bookstores.

ComputorEdge E-Books is now converting Marilyn's computer humor columns into e-books. The first book, Computer
Confusion in Paradise: Lo! And in the Beginning There Was Total Befuddlement!, is now available at our
E-Book Store (www.computoredgebooks.com/Humor-Computer-and-Internet-Anecdotes-and-
Jokes_c16.htm) in both EPUB format (www.computoredgebooks.com/Computer-Confusion-in-Paradise-
humor-EPUB-iPad-NOOK-COMPHUMORO0001-1.htm) for iPad, NOOK, etc., and MODI format (www.
computoredgebooks.com/Computer-Confusion-in-Paradise-humor-MOBI-for-Kindle-
COMPHUMORO0001-2.htm) for Amazon Kindle.
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Make a great program but put on a lousy user interface that makes the program confusing and hard to use, and people
won't like your program. Make a lousy program and put on a great user interface and people will think your program may
be better than it really is. The user interface defines the program (www.infoworld.com/d/application-development/
why-microsoft-developers-need-style-guide-186026).

While nobody can agree on the perfect user interface, people can agree on certain design principles (thinkvitamin.com/
design/10-user-interface-design-fundamentals/). Perhaps two main user interface principles are "Know your
user" and "Keep it simple.”

If you have a confusing user interface that just happens to work the way your user likes it to work, it doesn't matter how
confusing that user interface might be to others if it meets the needs of your most common user. In most cases though, you
want your user interface to be as simple as possible to stay out of the way while still being intuitive enough to use when
necessary.

If you've ever used a Microsoft product and found it hard to use, chances are good it's not your fault but the user interface's
fault. With each new version of Windows, Microsoft often changes the user interface for no apparent reason, which can
make the new version harder and more confusing to use than the older version. John Mueller, the co-author of C++ All-in-
One Reference for Dummies (www.amazon.com/gp/product/0470317353/ref=as_li_tf tI?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470317353), points out
the strange user interface changes Microsoft made to the Calculator program between Windows 95 and Windows 7.
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Figure 1. The Windows 95 Calculator program.

If you look at the Windows 95 Calculator program, it appears to offer pretty much everything you want. Now look at the
Windows 7 Calculator program and notice that Microsoft reversed the positions of the Edit and View menu titles. In most
programs, the Edit menu title appears furthest to the left followed by the View menu title, but in the Windows 7 Calculator
program, those positions appear switched.

Figure 2. The Windows 7 Calculator program.
Does reversing these two menu titles suddenly make the Windows 7 Calculator program easier to use? If not, why did
Microsoft bother to change this trivial detail for no apparent gain in usability?

Microsoft seems to change the Windows user interface just for the sake of change so their programmers can justify their
existence. One supposed advantage of Windows is that you don't have to learn a new user interface, yet each time you
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upgrade to another version of Windows or any Microsoft product, you have to learn a new user interface.

Microsoft's user interface design woes aren't just limited to Windows. In Word 2007, you can click the Insert tab and then
click the WordArt icon to view a list of WordArt styles. As you can see, if you want to create curved, wavy text, you just
need to click on one of the curved, wavy WordArt options and then type your text.

Figure 3. WordArt in Word 2007 displays curved text as an option.

How can you perform that same task in Word 20107 Click on the Insert tab in Word 2010, click on the WordArt icon, and
you see an entirely different list of options that only lets you choose a WordArt style, but not a curved, wavy option. To
create curved, wavy text in Word 2010, you must first choose a WordArt style, type your text, click the Text Effects icon on
the Format tab, choose Transform, and then choose one of many curved, wavy text options.

Figure 4. WordArt in Word 2010 only displays different WordArt styles.

By forcing you to go through more steps while making it harder to find the curved, wavy text options in the first place, Word
2010's user interface makes creating curvy WordArt harder than Word 2007. Is making users go through more steps while
making it hard to even find those steps an improvement in user interface design?

Microsoft's user interface incompetence doesn't just extend throughout their Windows programs. Starting with Office 2007,
Microsoft adopted a Ribbon user interface that displays a bewildering assortment of icons on different tabs in lieu of
traditional pull-down menus.
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On the Macintosh, Microsoft kept the traditional pull-down menus along with the traditional icon toolbar that offers the most
common commands such as a font list box and a font size list box. So far, so good. Then Microsoft added their Macintosh
version of the Ribbon interface. However, if you click the Home tab, you'll find that the Home tab also includes a font list
box and a font size list box, putting two font list boxes and two font size list boxes stacked one on top of the other.

Figure 5. Microsoft Word's bizarre user interface with two font list boxes and two font size list boxes.

What's the purpose of displaying duplicate, identical options on the screen? Does anyone think this makes Word for the
Mac easier to use?

Besides displaying duplicate font list boxes and font size list boxes, Word for the Mac's Home tab also displays duplicate
Bold, Italic, and Underline style options and left/center/right/justified alignment options. Perhaps the oddest duplication
occurs with the numbered list and the bullet list icons.

On the toolbar, the numbered list icon appears furthest to the left followed by the bullet list icon. Yet on the Home tab, the
bullet list icon appears furthest to the left followed by the numbered list icon.

Figure 6. Word for the Mac reverses the numbered list and bullet list icons.

It's bad enough seeing two numbered list and bullet list icons stacked on top of each other, but why did Microsoft reverse
their positions on the toolbar and the Home tab? Does anyone think this makes Word easier and more intuitive to use?

Go through any company's programs and you'll likely find user interface inconsistencies, yet Microsoft's user interface
changes shouldn't be so glaringly and consistently wrong. Microsoft should not only fire their user interface designers, but
they should publicly flog them on national television and then execute them afterwards for making the lives of millions of
computer users more complicated for no good reason.

The future of Microsoft continues to look cloudy. At one time, Microsoft ran numerous technology incubation labs to spur
innovation. Now ZDNet reports that Microsoft has shut down (www.zdnet.com/blog/microsoft/checking-in-on-the-
microsoft-labs/11870?tag=mantle_skin;content) most of these technology labs.

Given Microsoft's history of creating complex user interfaces to make simple tasks more difficult, does anyone still have
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faith that Microsoft should define the computing standard for the rest of eternity?
The World is Going Mobile

One reason for the decline in Windows PC sales is that more people are relying on smartphones and tablets (iPads) for
greater mobility. For more evidence that the world is shifting to mobile devices (www.electronista.com/
articles/12/02/12/comscore.shows.shift.to.mobile.in.mail/), comScore's latest report indicates that people are
relying less on Web-based e-mail in favor of native e-mail apps.

Figure 7. Web-based email access is down sharply among young people.

The only group still relying on Web-based email are the 45-54 crowd and the 65+ crowd. Most people under 24 rely on
Web-based e-mail less often, which may indicate that younger people prefer doing the bulk of their Internet use on mobile
devices instead.

As this youngest generation grows up, what are the chances they'll want to buy and lug around a heavier, bulkier laptop
instead of a smartphone or tablet? If more younger people are relying on mobile devices, the glory days of the PC are over.

In the old days, you either had a desktop or laptop computer to get on the Internet, or you didn't get on the Internet.
Nowadays, with more choices for Internet access, there's no need to rely on a PC for Internet access anymore. Just as
many people no longer have a landline phone in favor of a mobile phone, many people will likely shift entirely to
smartphones and tablets instead of desktop or laptop computers.

Unless you absolutely need heavy-duty computing power for computer-aided design or desktop publishing, many people
don't need a computer at all for the bulk of their work. For those who don't like tablets to create content, the next appealing
alternative is an ultrabook laptop such as the MacBook Air.

The world is going mobile and the world of PCs will never be the same again. That's great news for people anticipating this
shift to mobile devices, but horrible news for anyone still rooted in the business of traditional PCs. For those dependent on
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PCs for their livelihood, don't ignore the shift to mobile computing or you may find yourself in great company with people
who ignored the shift to PCs in favor of holding on to their typewriters, adding machines, and overhead projectors.

What's Apple Worth?

According to CNN, Apple is now worth more than Microsoft and Google combined (tech.fortune.cnn.
com/2012/02/09/apple-is-now-worth-more-than-the-gdp-of-sweden/?source=yahoo_quote). If this
doesn't accurately measure Apple's net worth, here are some other benchmarks that highlights how far Apple has come.
Apple is now worth more than:

The gross domestic product of Sweden ($458 billion)

All the gold in the Federal Reserve, and then some. ($350 billion)

All the illegal drugs in the world, and then some ($321 billion)

Six and a half years of global coffee consumption ($70 billion/year)

More than six years of U.S. beef consumption ($74 billion/year)

More than five U.S. Civil Wars ($74-$84 hillion each)

More than 2.5 Apollo space programs ($145-$170 hillion apiece)

Three times the entire U.S. clothing industry ($150 billion)

Fourteen National Football Leagues ($33 billion for all the teams combined)

With Apple's net worth skyrocketing, it no longer makes sense for anyone to ignore Apple any more. Why is Apple making
so much money? It's not because their slick marketing fools people into buying their products over and over again. It's not
because people want shiny new objects to boost their status among strangers. It's simply because Apple makes products
that people want to buy.

Just to understand how much Apple changed the smartphone industry alone, read this list from the CounterNotions site
that describes the mobile phone market (counternotions.com/2009/08/26/pre-iphone/) before the iPhone:

1. Carriers ruled the industry with an iron fist

2. To access carriers' networks handset makers capitulated everything

3. Carriers dictated phone designs, features, apps, prices, marketing, advertising and branding
4. Phones were reduced to cheap, disposable lures for carriers' service contracts

5. There was no revenue sharing between carriers and manufacturers

6. There was no notion of phone networks becoming dumb pipes anytime soon

7. Affordable, unlimited data plans as standard were unheard of

8. A phone that would entice people to switch networks by the millions was a pipe dream

9. Mobile devices were phones first and last, not usable handheld computers
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10. Even the smartest phones didn't have seamless WiFi integration

With such growing and overwhelming evidence that Apple has changed the smartphone market forever, does anyone still
think the iPad will fail because it doesn't have a replaceable battery, play Flash, or offer a built-in USB port? Does anyone
still think that Windows PCs sales will magically return to their former dominance despite the duel threat from mobile
devices and the constantly growing sales of the Macintosh every quarter?

More importantly, why do people still hate Apple, yet have no problems enjoying the benefits of Apple's influence on
smartphones, tablets, computers, and digital distribution? If you really hate Apple, just avoid using anything that Apple
helped influence such as personal computers with expansion slots (Apple 1), the graphical user interface and the mouse
(Macintosh), hyperlinks on Web pages (HyperCard), digital distribution (App Stores), touch screen interfaces (iPhone),
tablets (iPad), and interactive e-books (iBooks Author).

Apple and the Fair Labor Association

As the first technology company to join the Fair Labor Association (FLA), Apple has announced that the FLA will conduct
independent investigations of Apple's suppliers (www.apple.com/pr/library/2012/02/13Fair-Labor-Association-
Begins-Inspections-of-Foxconn.html) in Asia to insure that workers are treated fairly.

"We believe that workers everywhere have the right to a safe and fair work environment, which is why we've asked the FLA
to independently assess the performance of our largest suppliers,” said Tim Cook, Apple's CEO. "The inspections now
underway are unprecedented in the electronics industry, both in scale and scope, and we appreciate the FLA agreeing to
take the unusual step of identifying the factories in their reports.”

Now the real question is that if Apple is the first technology company to join the FLA, what about all those other technology
companies like Microsoft, Intel, Dell, Acer, Hewlett-Packard, Lenovo, Motorola, Gateway Computers, Nokia, IBM, Sony,
Toshiba, Sharp, and Asus who still haven't joined the FLA and who benefited from inexpensive labor in Asia for decades
during the big Windows PC boom from 1990 until now?

Shouldn't these other technology companies also join the FLA? More importantly, shouldn't people be upset that these
other technology companies turned a blind eye to the condition of Asian workers for the past few decades while earning
massive profits at the same time?

Stay Informed on Politics

Too many people vote based on their own prejudices rather than on actual facts. In case you haven't made up your mind
yet and enjoy following political news, download a free copy of ElectionCaster (www.handmark.com/applications/
electioncaster/) for the iPhone/iPad and Android.
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Figure 8. ElectionCaster provides political news from multiple sources.

ElectionCaster works by taking political news from various sources such as The Wall Street Journal and Politico, and
stores it S0 you can get your news from one source rather than hunt around various news sources on your own.

Of course, you may still prefer to do so just to verify that ElectionCaster isn't feeding you biased information, but by using
ElectionCaster, you can at least get a quick overview of the latest political news before you go wandering off on your own
to investigate other sites.

After reading political news, you may still not know which candidate stands for what, but at least you can pretend to be
informed when you cast your vote for someone who's willing to say anything and promise everything just to get your
support.

The Stubborn IT Mentality

InfoWorld recently published an article detailing the biggest mistakes (www.infoworld.com/t/it-management/its-
worst-addictions-and-how-cure-them-185797?page=0,0) IT departments tend to make. Not surprisingly, one of
the biggest problems stated was the IT department's insistence on maintaining power over the technology people in a
company can use, regardless of whether that technology is helpful or not.

Jeffrey Palermo, president and COO of Headspring, a custom software development and consulting firm says, "The root
cause is that most companies are organized by department instead of by function. Companies need to realize that having
all of their computing resources in one massive IT department that's supposed to magically manage priorities and
resources for every other department just doesn't work any more. They need to dishand the big IT departments, give each
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functional department their own tech staff and computing resources, and allow them to set their own priorities.”

A second problem with IT departments is that they rely on old methods while refusing to learn anything new. Although their
old methods may have worked in the past, that doesn't mean it will continue working in the present or the future, yet IT
departments tend to resist change to perpetuate their power within a corporation.

In many cases, the IT department winds up actively blocking change and interfering with technology that can make
corporate workers more productive. Of course, the IT mentality exists only because the tech-savvy IT workers feel the need
to maintain their authority through artificial barriers to progress rather than through actual competency in tailoring the best
technology for different corporate workers.

Thankfully, the rigid authoritarian rules of the IT department are slowly falling aside. Halliburton recently dumped
Blackberries (business.financialpost.com/2012/02/07/halliburton-abandons-blackberry-picks-up-
iphone/) in favor of the iPhone and many companies are finding it's less expensive and more efficient (www.zdnet.
com/blog/consumerization/enterprise-level-byod-and-the-quest-for-freedom-york-county-virginia/198?
tag=content;feature-roto) to let workers use whatever technology they like best such as iPhones, Android phones,
iPads, and Macs.

With consumer devices getting easier to use and maintain, corporations can cut costs by reducing the size and power of
their IT departments. When they do so, they may discover that for the past few decades, their IT department may have
actually been costing them money through their own stubborn inefficiency.

Playing MS-DOS Games

With the shift to Windows, game companies abandoned MS-DOS, yet there are still many MS-DOS games available for
free. In case you don't want to set up an MS-DOS virtual machine on your Mac, download a free copy of Boxer
(boxerapp.com/) instead.

Boxer lets you play MS-DOS games on Mac OS X so instead of paying money for the latest video games, just dig through

the vast collection of free MS-DOS games still available over the Internet. If you still have old copies of MS-DOS games
laying around, install them in Boxer and start playing away.
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Figure 9. Boxer lets you play MS-DOS games on a Macintosh.

When you're running a program, that program's icon appears on the Dock. Right-click on that program's icon and a menu
appears. At the top of the menu, you'll see a list of recently opened files. In the middle, you'll see a list of currently open
files so you can switch to a different open file quickly.
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Figure 10. Right-click on a program icon on the Dock to see recently opened files or currently open files.

In the early days, before Wally became an Internationally renowned comedian, computer book writer, and generally cool
guy, Wally Wang used to hang around The Byte Buyer dangling participles with Jack Dunning and go to the gym to pump
iron with Dan Gookin.

Wally is responsible for the following books:

My New Mac, Lion Edition (www.amazon.com/gp/product/1593273908/ref=as_li_tf tl?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=217145&creative=399373&creativeASIN=1593273908)
My New iPad 2 (www.amazon.com/gp/product/159327386X/ref=as_li_tf_tI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=159327386X)

Steal This Computer Book (www.amazon.com/gp/product/1593271050?ie=UTF8&tag=the15minmovme-

20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271050)
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Microsoft Office 2010 For Dummies (www.amazon.com/gp/product/0470489987?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470489987)

Beginning Programming for Dummies (www.amazon.com/gp/product/0470088702?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470088702)
Beginning Programming All-in-One Reference for Dummies (www.amazon.com/gp/product/0470108541?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470108541)
Breaking Into Acting for Dummies with Larry Garrison (www.amazon.com/gp/product/0764554468?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0764554468)
Strategic Entrepreneurism with Jon and Gerald Fisher (www.amazon.com/gp/product/1590791894?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=159079189)

How to Live with a Cat (When You Really Don't Want To) (www.amazon.com/gp/product/BO06DJYL70/
ref=as_li_tf tI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=B006DJYL70)

The Secrets of the Wall Street Stock Traders (www.amazon.com/gp/product/BO06DGCH4M/ref=as_li_tf tI?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=217145&creative=399373&creativeASIN=BO06DGCH4M)
Mac Programming For Absolute Beginners (www.amazon.com/gp/product/1430233362?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1430233362)

99% Fairy Tales (Children's Stories the 1% Tell About the Rest of Us) (www.amazon.com/gp/product/
BO06QSKM3A/ref=as_li_tf tI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=BO06QSKM3A)

The Zen of Effortless Selling with Moe Abdou (www.amazon.com/gp/product/BO06PUFPGl/ref=as_li_tf tI?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=BO06PUFPGI)

The 15-Minute Movie Method (www.amazon.com/gp/product/BO04TMD9K8/ref=as_|i_tf tI?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B004TMDIKS)

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15 Minute Movie
Method." (www.15minutemoviemethod.com/ ) Wally can be reached at wally@computoredge.com.
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Preventing the $11,336.62 Mobile Bill Shock
Cathy Sperrazzo from Eye-To-Eye Communications writes in this week:

Wireless & Mobile News reported a story about a Canadian family who racked up a bill of $11,336.62 this holiday for
allowing the kids to view Netflix movies.

A laptop was being used as an entertainment console for John Gibson's two grandchildren from Weyburn Saskatchewan
who were staying in Phoenix over the holidays causing major bill shock.

Using Netflix, the kids watched popular movies "Curious George," "Spider-Man" and "Shrek" from his Netflix account using
his laptop stick mobile broadband account incurring international roaming charges.

The international roaming fees at $6.00 per megabyte made each film cost around $400.00 to watch. SaskTel cut the bill
down to $1000, which the family plans on paying.

"Old guys like me just aren't up to speed on technology and what these things are capable of doing ... without you even
realizing it," Gibson said.

This reminds me of a Seinfeld episode in which George rents a movie for $1.99 and when he goes to return it, it cost him
an extra $2.00 for not rewinding. So he decides to keep it one more day and rewind it. Meanwhile, it gets stolen out of
Jerry's car, costing him more than $360. Bill Shock in the 90's over a movie is a bit different from John Gibson's experience
—with easy access to streaming movies on demand.

Enter Tangoe's Telicost-Lite, a free app that consumers can download to most mobile devices to get real-time monitoring
and alerts on data plan usage, voice, SMS and even roaming.

Check it out for yourself at Anomalous Networks (anomalousnetworks.com/telicost-lite/).
They Prefer the Past

According to Escalate Communications' Glenn Mandel, "With Facebook's Timeline rolling out to all 800 million users,
SodaHead.com polled its users to get their thoughts on the new design. In a landslide, 70% of poll respondents stated that
they did not like Timeline and hoped that Facebook would "lose it." Only 20% indicated that they liked it, while 10% said
that they were not Facebook users.
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"While 30% of users between ages 18 and 24 like Timeline, only 10% of those over 65 were happy with the new design.
When broken down by gender, men and women had exactly the same opinion—77% dislike Timeline, while 23% like it."

Full poll results can be seen at SodaHead.com (www.sodahead.com/united-states/public-opinion-rejects-facebook-
timeline-infographic/question-2429779/).

Apple Users Demand an "Ethical" iPhone 5 and iPad 3
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Amanda Kiloer, Organizing Director at the on-line social change platform Change.org, notes that concerned Apple
customers recently delivered more than a quarter million signatures from campaigns on Change.org and SumOfUs.org to
Apple's Grand Central Station, NYC location demanding the company respond to recent criticisms of worker abuse in their
supplier factories and commit to creating an "ethical” iPhone 5. (It's important to note that many companies—not just Apple
—manufacture products in conditions similar to those documented below):

Mark Shields, a self-identified Apple "super-user" launched the campaign on
Change.org after listening to a radio program detailing allegations of labor abuses
at an Apple supplier factory in China, including child labor, serious physical injuries
of workers from repetitive motions during long shifts, and stress-related worker
suicides.

"Apple is supposed to 'think different," which is one of the reasons | love and use
the products they make," said Shields. "But the horrible human suffering that goes into making Apple products isn't what
they promise in their brand. | was heartsick when | learned what was really happening. These working conditions are
appalling, especially for Apple.”

More than 55,000 SumOfUs members have signed that organization's petition already,
making it the most viral petition since SumOfUs, a new global grassroots community of
consumers fighting for corporate accountability, launched just over two months ago. More
than 35,000 of the petition signers say they buy Apple products, including over 20,000 iPhone
users.

"| use an iPhone myself," said Taren Stinebrickner-Kauffman, executive director of SumOfUs.
"l love it, but | don't love having to support sweatshops, and neither do millions of other Apple
consumers. The hip, educated market that Apple aspires to corner is largely composed of
responsible consumers who don't want to be complicit in sweatshop labor. Apple's attention
to detail is famous, and the only way they could fail to be aware of dozens of worker deaths, of child labor, of exposure to
neurotoxins is through willful ignorance. That's why our members are asking Apple to clean up its supply chains in time to
make the iPhone 5 its first ethically-produced product."

The petition delivery was coordinated globally by concerned consumers. Petition deliveries took place in Washington, DC,
New York, San Francisco, London, Sydney, and Bangalore, all asking Apple to improve its commitment to worker
protection.

Live signature totals from Mark Shields' Change.org campaign can be found at Change.org (www.change.org/petitions/
apple-ceo-tim-cook-protect-workers-making-iphones-in-chinese-factories).

Run Windows, Linux, and more on Macs

Before 2006, Macintoshes typically were perceived as “incompatible (www.manu-j.com/blog/naysayers-
apple/413/)" because their hardware did not natively run Windows or apps written for Windows. Apple addressed that
perception in 2006 by equipping Macs with the same Intel chips (en.wikipedia.org/wiki/Apple_Intel_transition) as
in Windows PCs, and by producing Boot Camp software (www.macworld.com/2006/06/secrets/tcowindows/
index.php?pf=1) that natively installs and runs Windows. Boot Camp's primary drawback, however, is that it cannot run
Mac OS X and Windows at the same time; Mac OS X must be shut down before running Windows, and vice versa. This
drawback can be avoided by replacing Boot Camp with a virtualization program such as VMWare Inc.'s Fusion (www.
vmware.com/products/fusion/overview.html).

Fusion, like other virtualization programs, creates a Virtual Machine (VM) that launches and displays another OS (Linux or
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Windows, for instance) within a window as if it were just another program (Figure 1). Because Macs have the same CPUs
as Windows PCs, Fusion's VMs can run almost any Intel-based OS or app alongside Mac OS X. Thus, Fusion expands
and enhances a Mac's compatibility and functionality.

Figure 1. Fusion displays a guest operating system within a window on Macs booted into OS X; for example, Windows XP (left) and
Windows 7 (middle) each runs in its own window. This virtualization program officially supports over 150 guest operating systems,
including Mac OS X Lion (right).

Why would anyone want to use Fusion to run Linux or Windows in a Mac-hosted VM? One of several compelling reasons is
that newcomers to the Mac platform might want to continue using familiar Windows- or Linux-based programs while
learning Mac OS X. Another reason...users who require a program that is not written for Mac OS X most likely will be able
to run it in a Fusion VM on their Mac. Developers of dual-platform software and/or Web sites can test their products on a
single computer, using Fusion VMs, instead of testing on multiple computers. Lastly, Fusion VMs could help to avoid
malware that infects Windows PCs but not Macs (for example, use Mac OS X to receive or send email, surf the web, and
download software; use a Windows VM to perform all other tasks that don't require the Internet or other potential sources of
malware).

In addition to the above reasons for using Fusion VMs to run Windows or Linux, there's a potential financial advantage. If
you already own or intend to purchase an Intel Mac and need to run a Windows-only app, why buy a $300 PC when you
can buy Fusion for a fraction of that cost ($49.99 for existing and new buyers)? Fusion also could be a time-saving
alternative to purchasing a cheap PC that eventually will need to be maintained, serviced, and disposed. And, to reiterate,
Fusion solves the primary weakness of Apple's free Boot Camp software—it runs Mac OS X and another OS side-by-side
rather than needing to shut down one OS in order to boot into the other.

Fusion is a mature and actively developed software product. Its current version (4.1.1, released on November 23, 2011) is
loaded with ingenious and useful features. Version 4.0 introduced 90 new features, way too many to list and discuss in this
review. Instead, here's a brief rundown on ones that are likely to be of interest and/or benefit to Mac users. Details are

available at VMWare's Web site (communities.vmware.com/servlet/JiveServlet/previewBody/17077-102-1-
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22031/What's%20New%20in%20VMware%20Fusion%204.pdf).

An intriguing new feature in Fusion 4 is support for installing Mac OS X Lion in a VM (Figure 1). Lion is the first client
version of Mac OS X for which Apple officially authorizes virtualization (Apple authorizes virtualization (reviews.cnet.
com/8301-13727_7-57329027-263/vmware-4.1-lifts-block-on-snow-leopard-client-virtualization-
updated/?tag=txt;title) of Snow Leopard Server, but not Snow Leopard client). Support for installing Lion in a VM
means that you can test drive third-party programs in the VM without risking the stability of your bootup Lion installation or
cluttering it with timed-out demo apps that you've decided against purchasing.

Fusion 4 is the first version that supports Lion's headline new features, including File Vault 2, full screen mode, LaunchPad,
and Mission Control (Figure 2). Support for Lion's new features means that now VMs can be encrypted, icons of Windows
apps installed in a VM are included in a screen that resembles iDevices' home screen (Figure 2, top), and apps running
under a Windows VM are included in a screen that shows all active apps and their open windows (Figure 2, bottom),
respectively.
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Figure 2. The latest and greatest Fusion version (4) adds LaunchPad (top) and Mission Control (bottom) support for Mac OS X Lion
users. The former feature, like iDevices' home screen, displays installed apps—including Windows apps installed in a Fusion VM—
and the latter displays all open apps—including Windows apps running in a Fusion VM—for rapid switching.

Another prominent new feature in Fusion 4 is its support for multiple snapshots—"pictures in time"—of installed VMs.
What's so special about that? Suppose you want to check out a third-party app with a time-limited demo mode. Before
installing it in your VM, take a snapshot of the VM's current condition. Then, after taking the app for a test drive, you have
the option to simply revert to the pre-installation snapshot instead of fussing with uninstalling the app. Or suppose you
apply an update to the OS installed in a VM and it glitches. If you've taken a snapshot prior to the update, simply revert to
the pre-installation snapshot and you're back in business. Snapshots in Fusion 4 additionally have a new Library display
and an enhanced AutoProtect feature which automatically makes periodic snapshots of installed VMs for safety's sake
(Figure 3). Note that snapshots are not the same as backup copies of VMs.

Fusion 4 is the first version with a Pause feature (www.vmware.com/products/fusion/migrate.html). If you run
multiple operating systems at the same time and want to quickly release system resources for other apps, this handy
feature does so by immediately pausing the selected VM. Note that this is different from suspending or shutting down a
running VM. In my tests, using the Pause feature on a Lion VM did release the VM's CPU allocation but not the RAM
(Figure 3), and Fusion automatically suspended a paused VM after | quit Fusion (indicating that the Pause feature is
effective only while Fusion is running).
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Figure 3. Fusion 4's new AutoProtect feature automagically takes snapshots of an installed VM so that the user can revert to a
previous condition of that VM in the event of an unexpected mishap. Its new Snapshots screen provides a user-friendly organization
of a VM's snapshots history.
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Figure 4. Fusion 4's new Pause feature officially is supposed to release CPU and RAM allocations, however in testing for this review
it only released a Lion VM's CPU allocation; Activity Monitor's statistics before pausing Lion VM are on the left, after pausing are on
the right.

One more new feature in version 4 worth mentioning here is Fusion's 64-bitness. Fusion 4 is completely written in Mac OS
X's Cocoa programming environment, and all of its component apps are now 64 bit. This means that Fusion 4 takes
advantage of 64-bit support in Lion and current Macs' Intel CPUs. This new feature will be attractive for speed and
performance jockeys.

In addition to expanding and enhancing a Mac's compatibility and functionality, Fusion provides additional advantages for
Mac owners who need/want to run Linux, Windows, and programs not written for Mac OS X. Some of the following
advantages are unique to Fusion. Others also are provided by competing VM programs (Parallels Desktop and VirtualBox).

+ Up to 150 different OS flavors (partnerweb.vmware.com/GOSIG/home.html), including Windows XP and Vista,
are officially supported. Note that Boot Camp for Lion has dropped support (support.apple.com/kb/HT4818#3) for
Windows XP and Vista).

* If you're willing to ignore Apple's license agreement and if you can obtain the installer for Fusion 4.1, you can install and
run Mac OS X Snow Leopard client (www.macworld.com/article/163755/2011/11/
vmware_fusion_update_lets_users_virtualize _leopard_snow_leopard.html#lsrc.rss_main) in a Fusion
4.1 VM due to the omission of a routine (www.macworld.com/article/163795/2011/11/
vmware_backtracks_on_os_x_client_virtualization.html#lsrc.rss_main) that checks the Mac OS X version.
The version-checking routine has been restored in Fusion 4.1.1; this update removes the capability to install Snow Leopard
although you still can install Snow Leopard Server, Lion client, or Lion Server in Fusion 4.1.1 VMs.

* Hard drive partitioning is not required.

* Fusion VMs should run with little slowdown because they execute natively on a Mac's Intel CPU; no translation of code is
required.

* Windows Easy Install (WEI) is a user-friendly and seamless way to create a new VM, install Windows into the new VM,
and get up and running. This feature (a Wizard-like sequence of dialogs) works with an installer image file or optical disc
and creates a VM, selects the default Windows installation options, and installs drivers (VMWare Tools) for optimal VM
performance and compatibility. WEI officially supports Windows 7, Windows Vista, and Windows XP, plus Windows Server
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2008, Windows Server 2003, and Windows 2000 Server.

* A truly slick feature is Fusion's Unity display mode. Unity displays Windows VM apps without displaying Fusion's or
Windows' interface (Figure 5), thereby shielding the user from Windows and delivering a more Mac-like experience.

Figure 5. Fusion's Unity mode displays Windows apps as if they were native Mac apps, hides the VM's window, and hides Windows'
user interface. Cool!

* The user can share folders and files plus copy-paste between the VM and Mac OS X, print from the VM, access
peripherals (USB pen drives, hard drives, optical disks, etc.) from the VM, and more. All of these functions worked properly
during my testing with a Windows 8 developer preview VM and Lion VM after installing the aforementioned VMWare Tools.

* Fusion comes with a pretty generous technical support policy (www.vmware.com/support/services/
complimentary.html). Users are eligible for 18 months of assistance/support via email after registering the program.
After the 18 months of support, users can purchase telephone support. Access to the company's online knowledge base,
documentation, and discussion forums is free and unlimited.

* This program also includes 12-months complimentary subscription to McAffee VirusScan Plus for virus protection (or
users can install Microsoft's optional, free Security Essentials).

As mentioned earlier, whichever OS is installed in a Fusion VM should perform with little loss of speed because it runs
natively (without code translation) on a Mac's Intel CPU. VMWare's media guide states that "VMware Fusion 4 outperforms
Parallels Desktop 7 in real-world graphics applications. Autodesk 3ds (DirectX) completes 20-70% faster, and Photoshop
up to 10% faster." This statement is based upon results from WorldBench 6 (en.wikipedia.org/wiki/WorldBench) (a
performance benchmarking tool that uses common Windows applications) in tests comparing VMware Fusion 4 (build
474597) and Parallels Desktop 7 (build 14920) on a late 2009 27" iMac with 16 GB RAM and mid-2011 13" MacBook Air
with 4 GB RAM using freshly created virtual machines using Windows 7 64-bit SP1.
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MacTech has published the results of exhaustive benchmark comparisons (www.mactech.com/2011/11/01/
mactech-labs-virtualization-benchmarks-fall-2011) that used a greater variety of test suites (SPEC tests,
PCMark, WorldBench, Performance Test, Unixbench and others) and host Macs (five models—the white MacBook,
MacBook Air, MacBook Pro, iMac, and Mac Pro equipped with a minimum of 4 GB RAM). They found that "Parallels is the
clear winner. If you count up the general tests (including the top 3D graphics scores), Parallels won 60% of the tests by
10% or more. ... Parallels Desktop 7 beat VMware Fusion 4.0.2 in 74.9% of the general tests we ran, and Parallels was
double the speed or more in almost a quarter of the top-level tests."

The benchmarks' authors cautioned that Microsoft Office 2010 with Windows Update configured to do updates can
confound the results of benchmark testing due to the automatic installation of Microsoft Security Essentials (MSE).
MacTech found that MSE "...had an impact on basically anything that touches the disk (boot times, compress, network
copies to disk, and more). In fact, in the current version of [Parallels Desktop] 7, it eliminates some of the speed margin
we've seen in the past when compared to [VMWare Fusion] 4 [which] did not seem to be impacted, or at least as much.”

So whose benchmarks are correct? Most likely both are, given the considerable differences in the tests' conditions. Suffice
to say that your mileage may vary depending upon which model Mac you use, how much RAM is installed (more is better),
whether your Mac has a conventional hard drive or a solid state drive, and what flavor of Windows or Unix and what apps
you're using in a Fusion VM. Regardless, if gaming is your thing, performance will be better if the game runs under Boot
Camp Windows than under virtualized Windows.

Fusion has all of the above advantages, and it also has several noteworthy weaknesses. Perhaps the most important
weakness, which also affects other virtualization programs, is that if you want to run Windows apps in a VM, you need to
install and maintain Windows. That means dealing with anti-malware software, updating and maintaining Windows, fussing
with the registry, and defragmenting the virtual hard drive.

Another weakness is that, under certain conditions, VMs make heavy use of a swap file rather than RAM which can result
in the dreaded wait cursor (AKA "spinning beachball") in the VM and/or host Mac OS X. One condition where this occurred
during my testing was while Fusion was running with three VMs all in suspended state and Safari open in the host Mac OS
X. Performance was noticeably smoother without Safari running.

Time Machine users need to be aware that, each time they make a change in their VM that affects its files, those files will
be backed up to the Time Machine drive and rapidly consume the drive's available space. One management strategy
would be to exclude the "Virtual Machines" folder in the user account's Documents folder, and instead manually make
backups of the VM files when appropriate.

Lastly, Fusion's Menu Extra, by default, is installed in Mac OS X's menubar. Although this feature affords systemwide
access to installed VMs, menubar space could be constrained for users with small monitors and it would be convenient if
Fusion's Menu Extra could be removed.

In summary, VMWare Fusion is a mature, full-featured virtualization app that enhances and expands a Mac's functionality
and compatibility. This program's price tag is a bargain for what it delivers, and its tech support policy is entirely
reasonable. Highly recommended for Mac owners who need to run a Windows-only app and/or want a virtual version of
Lion.

DHOD ¢

Review contributed by Barry Fass-Holmes
Verizon 7" Galaxy Tab

If you're smitten with Samsung's original 7" Galaxy Tab Android OS tablet, you can still pick one up for $229 plus a two-
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year contract at verizonwireless.com. But not for long. This model will soon be replaced by the newer 7" Plus model (1.2
GHz dual core, Android 3.2 Honeycomb OS) and the larger 8.9" (which we'll soon be reviewing in its AT&T iteration) and

10.1" Tabs.

One place the 7" Tab excels is the screen. I'm not a big fan of the Motorola Xoom's screen, for example, which, although
fast and crisp, has a much-commented washed out appearance, like a slight fog has settled over the screen. Drives me

nuts. The Tab's display boasts rich, deep colors you can really get lost in. Looks almost as rich as an OLED or Super

AMOLED screen.

Quick specs (from Verizon):

Android 2.2 (Froyo) Operating System

V CAST Apps, V CAST Music and V CAST Song ID

Dimensions: 7.48" (H) x 4.74" (W) x 0..47" (D)
Weight: 13.58 ounces

Display

7.0" Touch Screen

1024x600 WSVGA TFT LCD display
Supports up to 16M colors

6—Axis Motion Sensor and Accelerometer

Keyboard
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Virtual QWERTY Keyboard with Swype and Samsung keypad options
Battery

Usage time: up to 780 minutes
Standby time: up to 500 hours
SAR: Body 1.01 W/kg

Memory/Processor

1GHz Cortex A8 Hummingbird Processor
2GB internal memory & 16GB microSD card pre-installed
Up to 32GB microSD Optional Removable Memory Supported

Camera

3.0MP rear—facing camera
Auto-focus

Flash

1.3MP front-facing camera

Video

3.0MP rear—facing camcorder
DivX HD video playback

Music

Create and Manage playlists
Music Player For: MP3, WMA, AAC, AAC+, eAAC+, MIDI, WAV, & SP-MIDI Formats
Headset Jack: 3.5mm

Web

HTML Browser with Adobe® Flash® 10.1

Wi-Fi (802.11 b/g/n)

Thousands of apps & hundreds of widgets available on Android Market

Amazon Kindle e-Reader

Google Services including Gmail, Google Talk, YouTube, Google Calendar, Google Search, Google Maps, Latitude, Places
Thousands of apps & hundreds of widgets available on Android Market

Bluetooth
Bluetooth Profiles: Object Push for vCard & vCalendar, SPP, BPP, A2DP, AVRCP, GAVDP, AVDTP, and AVCTP

To me, the 7" tablet form factor feels just about right. Easy to carry, easy to hold, easy to read. While this model is not quite
as spiffy as the above-noted Plus, if you're just checking your e-mail, playing some tunes, and browsing the Web, you'll
likely not notice a huge difference. If you want it to play graphic-intensive first person shooters, fork out the extra $150 or so
for the 7" Tab Plus or an even larger tablet.

OB ¢
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In addition to being an editor and columnist for ComputorEdge and ComputerScene Magazines, where he has
written hundreds of feature articles and cover stories over the past decade, Charles Carr has also penned well over 1,000
non-tech newspaper and magazine articles and columns for various publications, including two widely-read columns each
week for San Diego's North County Times newspaper.

Carr has covered such diverse topics as pesticide use in area schools, invasive background checks for county volunteers,
asthma awareness, the debate over standards-based grading, potential vulnerabilities in electronic voting machines, and
Southern California's devastating 2003 and 2007 wildfires. He has also written many humorous pieces.

Carr has also edited dozens of stories and articles written by others which have appeared in major publications and web
sites across the country.

He has been a contributor and technical advisor to L.A. and San Diego Parent magazines and receives dozens of

requests a year to appear on Southern California television and radio stations to talk about important events in the tech
world.

Carr has judged many writing competitions including San Diego Press Club and Time-Warner Communications contests
and was sole judge for the national NAPPA Tech Toys awards for five years (which his kids really appreciated). He was
recently a judge for the national "Poetry Out Loud" competition.

He has won many writing accolades, including Press Club awards for Best Column Writing, Consumer Writing and Best
Arts and Entertainment, and has repeatedly taken top honors in San Diego Songwriter's Guild competitions for his original
musical compositions.

Carr will soon publish his first book, What a World, a collection of his best writings.

Learn more at www.charlescarr.com.

37 of 44



ComputorEdge 2/17/12

Return to Table of Contents

The Midnight Hacker

“A Very Short Story about the
Perils of Hacking.” by Ellen Dawn
Benefield

"The Midnight Hacker strikes again!" Lester
Gulch crowed with triumph as he launched his
Trojan virus though a harmless appearing e-
mail."

"The Midnight Hacker strikes again!" Lester Gulch crowed with triumph as he launched his Trojan virus though a harmless
appearing e-mail.

"Take that and that and that—all of you stinking losers—my boss keeping a genius like me at the bottom—experience or no
experience. | know more than all those old farts put together. And here's a present to all those women who refuse to date
me and here's for the players of The Winter of Nevermore for disqualifying me and everyone else in the world on general
principles—you all suck! Just try and use your virus protection. All of them will fail. I win. You lose!"

He collapsed into his chair as his rant finally ran out of steam. Three days of no sleep was catching up with him. Lester's
eyes closed as he leaned back in his chair and he started to snore.

"Ding. You have mail." Curious, Lester opened it.

One of his virus laden e-mails had returned with a message. "I'd turn back if | were you." There was a small figure of a
wizard shaking his finger. The wizard appeared to be glaring right at him.

Lester snorted. "Who do you think you are? The Wizard of Oz? You'll never get past my protection, buddy. Whoops."
Lester worked feverishly to stop the program trying to overwrite his. It took him all afternoon.

"There, done. Finally figured out the point of origin. Nobody is smarter than Lester Gulch. Nobody." He sent the Trojan
again.

Ding! It returned in an instant. This time there was just a hand on the screen shaking its finger at him and a message "Uh,
uh,uh!"

"Screw you! This means war. You are just a powerless avatar. You can't do anything. I'm the one with all the power. Best to
be careful, though. Tomorrow I'll switch computers and programs and send a more powerful virus." He yawned. "I really
need to catch some zzz's. Too many nights without sleep. Day off tomorrow. | can rewrite the program then. Stinking little
avatar. You will die, die, die.  am The Midnight Hacker. Who do you think you are? BTW the king is a fink and so is his
wizard. Good name for my new program.”
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Les woke from his nap refreshed and eager for battle.

"Finito! Wizard Killer is ready to launch. I'll get you and your little dog, too. Pretty you're not. No wanna be avatar will defeat
me. Launch Trojan," he gloated as he pushed send on the e-mail. It returned promptly—this time playing a familiar melody.

"Isn't that from some opera? You're enjoying this aren't you, loser? You're laughing at me. Don't laugh at me! How dare you
laugh at me."

Elmer Fudd's voice came from the microphone, "Kill the rabbit, kill the rabbit, kill the rabbit, kill him now."

"Isn't that supposed to be ‘wabbit" you moron? My mother showed me that cartoon on YouTube. You must be some kind of
whackadoodle and old to boot. Now what are you going to do, you old fart?"

He blinked. A fist appeared on the screen enclosed in a mailed gauntlet. The fist shook at him.

"Oh, your mother wears combat boots and rides a broom!" Les changed the program slightly and sent it one more time. He
paced the floor. It returned promptly. This time the fist was unclenched and it beckoned to him. Les swaggered over to the
screen and tapped it.

"An avatar's hand. You'll have to do better than that you old fart imitation wizard!"

The hand shot out of the screen—seized him by the throat and shook him like a dog shakes a rat. His last coherent thought
before he passed out was—-what the f? This can't happen. . .

Les finally regained consciousness to find himself looking at the smoky remains of his computer. His hard copies littered
the room like confetti. Everything in his room was ruined. Les groaned and put his hands to his aching head.

"You win. No more hacking. I'm taking up something easier—like robbing banks."

Ellen Dawn Benefield has had stories published in ComputorEdge, Millennium Science Fiction and Fantasy
Magazine and the Wyrd Wravings Anthology of Funny Speculative Fiction. She has also taken five
Honorable Mentions in the Writers of the Future Contest. She is a member of SFWA and is currently working on a
Paranomal romance novel as well as polishing a Science Fiction novel and a Funny Fantasy novel. Ellen is an ecletic
individual who has trained horses, raised Shelties, taught riding and dancing including ethnic and belly dancing. She
expects to publish a novel this year possibly on Smashwords and Amazon.com.
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Editor's Letters: Tips and Thoughts from

Readers
“Computer and Internet tips, plus comments on
the articles and columns.” by ComputorEdge Staff

"CAD (Computer Aided Design)," "About Apple's Creative Ideology," "Time

Machine When Getting New Mac? Unnecessary," and "Why Folks Buy
Apple after Buying Apple,”

CAD (Computer Aided Design)
[Regarding the January 20 Digital Dave column:]

Any decent cad software will have a learning curve. AutoCAD is the industry standard and the way to go, but is very pricy
for the new release. However, you can get great deals on older versions and on their Lite version at sites like eBay.
AutoCAD 2000 or 2004 would be more than adequate for the beginner and would probably cost no more than $50 used.

-Billy, Encinitas
Dave,

A free and somewnhat easy to use CAD program is Google's SketchUp (sketchup.google.com/). Not only is it free, but
there's tons of online support and tutorials for it; not only by Google, but YouTube is teeming with how-to's. There's also an
online warehouse where users have posted thousands of their creations so anyone can see how they did them.

-John, Encinitas, CA

In 1/20/2012 Digital Dave Column, Peter also asked about getting a larger print than a size A - ("l can only print out "A"
size"), ("or perhaps there's a way to print in sections and tape the sections together"). Would being able to print a large
poster of the work help him?

Block Posters (www.blockposters.com) is a Web site mentioned in the Kim Komando.com e-mails | receive. It is for
being able to print out your own poster (by sections) from your pictures. It is touted as free, not counting the cost of paper,
ink, etc. You can read the Kim Komando e-mail tip (www.komando.com/downloads/category.aspx?id=6941). |
would imagine Peter could save his work in a format that could be used to create Block Posters. Most of what KK produces
is geared for newbies, but she has a lot of gems in her collection.

-Bill, San Marcos, CA

About Apple's Creative Ideology

[Regarding the January 20 Editors Letters: Tips and Thoughts from Readers column:]
To Al:

First, let's clear up some of your latest comments.

"They say that the world would be a much better place if Microsoft Corporation would collapse; then
everybody would (be forced to) use a Mac... and be happy."
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Who said this? What | constantly say is that people should objectively compare the facts of a
Macintosh vs. a PC, taking into account that a PC will instantly fragment a hard drive, corrupt its
Windows registry every time you install a program, and gradually slow down over time as a result if
you do not constantly defragment your hard drive and optimize your Windows registry. These
problems aren't hard to fix, but for someone who doesn't know about them, they'll experience
frustration using a PC because of their technical ignorance. On the other hand, someone can be
technically ignorant and use a Macintosh without worrying about disk fragmentation or Windows
registry errors. Based on these technical flaws inherent in Windows that are lacking in the Macintosh,
| believe the average consumer, who doesn't know much about computers, would be better off
buying and using a Macintosh.

"If Apple's ideology is about creativity, then why do they maintain a closed hardware approach?"

What does a closed hardware approach have to do with creativity? Many creative people such as
graphics designers use a Macintosh specifically because they don't want to fiddle with the hardware
of their computer. They would rather spend their time working on their computer rather than working
to keep their computer running. When you're wasting time maintaining your computer, it's hard to be
creative doing anything else. By confusing closed hardware with creativity, you're simply making up
problems that don't exist.

"Remember, you cannot upgrade and repair your own Mac."

You can upgrade and repair a Mac Pro. You can also easily upgrade the RAM of the Mac mini and
iMac. In fact, if you're using Lion, click on the Apple menu and choose About This Mac and then click
the More Info button, your Macintosh will even tell you the exact size (such as 4 GB), speed (such as
1333 MHz), and type of memory (such as DDR3) that your Macintosh has. Now you can easily
purchase the correct memory chips for your particular Macintosh. Can you easily find the right
memory speed and type of chips on a typical PC if you can't find the motherboard manual and don't
know the exact model of your PC? In this respect, it's actually easier to upgrade the memory of a
Macintosh than it is to upgrade the memory of a typical PC, especially for the average person.

"You will have to take it to an Apple Store/Service center. Then they will either suggest hundreds of
dollars in repairs, or '...why not just upgrade to the new iMac?'—either way, hundreds of dollars."

If you do not know how to fix and upgrade your PC, you will also have to take your PC to a computer
service center that will either suggest hundreds of dollars in repairs or ‘why not just upgrade to a new
PC?'—either way, hundreds of dollars. You're assuming that most people know how or want to learn
how to repair and upgrade their computers, but most people do not just as most people do not want
to change their own oil in their car. That task is not difficult, but oil change businesses exist to cater
to people who do not want to bother changing their own oil. In the same way, most computers users
do not want to learn how to repair and upgrade their own computers because they lack technical
knowledge and skill and do not wish to spend time learning these skills. For a person who lacks the
skill and knowledge to repair and upgrade a PC, they'll also be left to the whims of a computer
service center and they'll also be forced to pay a potentially large repair bill. So how is this any
different than fixing and repairing a Macintosh? Having the choice to fix and upgrade your PC is
useless if you do not also have the skill, time, and desire to fix and upgrade your PC.

"That's why they set the AppleCare product so high in the first place; to discourage you from buying
it when you (bought) your iMac/Mini."
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You have proof that this is exactly why they set the Apple Care price so high in the first place? Many
companies such as Best Buy offer to sell you an extended warranty when buying a PC. How is this
any different than Apple Care?

"As a PC user, | have choices. | can upgrade anything | want to on my PC."

Unless, of course, you buy an all-in-one PC like the Hewlett-Packard Omni 120z PC. Of course, if
you buy this PC, that's a choice, just like buying a Macintosh is a choice. Remember how easy it is to
find the exact speed and type of memory chips you need for a Macintosh, but cannot easily find this
same information on a typical PC. That makes upgrading the memory of a PC much harder because
you're forced to look up the motherboard type or the PC model type to track down the type of
memory chips it uses.

"I don't have all those perceived evil PC slowdowns, etc.”

Really? If you do not experience slowdowns of your PC from disk fragmentation and Windows
registry errors, then why do so many services exist to speed up a PC (for a price, of course, which is
a price Macintosh users never have to pay since registry errors do not exist on the Macintosh). The
fact is that Windows PCs do slow down over time through disk fragmentation and Windows registry
errors, and to deny this fact is simply to deny the reality that many Windows PC users do experience
slowdowns over time. Claiming that you do not experience these evil PC slowdowns does not imply
that the vast majority of Windows PC users also do not experience these slowdowns, as numerous
PC speed up services and software seems to suggest.

"Open and creative, pfft!"

Perhaps what's really not open is your willingness to objectively consider the advantages of the
Macintosh and what's really creative is your insistence that PC slowdowns never occur to the vast
majority of Windows PC users, pfft!

-Wally

Time Machine When Getting New Mac? Unnecessary

[Regarding the January 20 Wally Wangs Apple Farm column:]

Why use Time machine? Just use the transfer program that comes with your new Mac to move all your settings?
-Rich, San Diego, CA

The main reason to use Time Machine instead of the Transfer program is that the Transfer program

requires that you have a cable to connect two Macs together. If you don't have that cable, you'll have
to buy it. However, if you have an external hard drive plugged into your old Mac through a USB port,
you can just plug it into the USB port of your new Mac without buying anything extra at all.

-Wally Wang

Why Folks Buy Apple after Buying Apple

[Regarding the January 20 Wally Wangs Apple Farm column:]

"Once someone buys an Apple product and likes it, they'll be more likely to buy another Apple product as a companion or a
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replacement. "

This is because Apple makes it so hard to interface their products with other's products, folks have to buy Apple to use
them with each other.

-Rich, San Dieo, CA

I'm not sure what you mean by stating that Apple products are difficult to interface with other
products. All Macs have USB ports that are a universal standard and now many PCs are starting to
get Thunderbolt ports, which will allow Macs and other products to connect together.

On the software side, Microsoft is perhaps the bigger culprit because they make proprietary file
formats to keep people locked into Microsoft Office. Perhaps it's more accurate to say that people
buy Windows PCs because Microsoft makes it so hard to be compatible with other products.

-Wally Wang

ComputorEdge always wants to hear from you, our readers. If you have specific comments about one of our articles,
please click the "Tell us what you think about this article!" link at the top or bottom of the specific article/column at
ComputorEdge.com (webserver.computoredge.com/online.mvc?src=ebook). Your comments will be attached

to the column and may appear at a later time in the "Editor's Letters" section.If you want to submit a short "ComputorQuick
Review", or yell at us, please e-mail us at ceeditor@computoredge.com. If you would like to contribute to
ComputorEdge endeavors, please visit ComputorEdge E-Books (www.computoredgebooks.com/Contribute-to-
ComputorEdge-Magazine_c3.htm).
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Send malil to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.
Copyright © 1997-2012 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 573-0315
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